
 

 

Important 
．The graphic above shows an example of a PDA operating window. 
The connection procedure may be different depending on the manufacturer or 
model of PDA you use. Please refer to the product instruction manuals for further 
details.  

The [Bluetooth Settings] window will open. 
The message "Connection not registered" will appear if no Bluetooth device has 
been registered. 

 

Please tap on [OK] to close the message. 

2. Double click on [Tools] [Search for peripheral components]. 
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The application searches for nearby Bluetooth devices. 

3. Tap and hold on the destination PC icon, and then select [Update Services]. 

 

A search for services will be carried out, and then a list of service names and their 
connection status will appear as list in the lower window. 
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4. Tap and hold on "COM7" from the list of service names, and then select 
"Register ActiveSync". 

 

5. Tap [OK] in the confirmation message window. 
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An ActiveSync connection will be initiated. 

Establishing a partnership between ActiveSync and a PDA 

Once a connection has been successfully established with a PDA, the procedure for 
establishing a partnership with the PDA will be started by the ActiveSync application on 
the PC. 
Performing this set-up procedure will enable data to be synchronised between your PC 
and PDA. 

1. In the [New Partnership (Set Up a Partnership)] window, select "Standard 
partnership", and then click on the [Next] button. 
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The [New Partnership (Specify Data Synchronisation Method)] window will appear. 

2. Select "Synchronise with this PC", and then click on the [Next] button. 

 

The [New Partnership (Select Synchronisation Settings)] window will appear. 

3. Select the type of information to be synchronised between your PC and PDA, 
and then click on the [Next] button. 
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The [New Partnership (Completing Setup)] window will appear. 

4. Click on the [Finish] button. 

 

When you click on the [Finish] button, ActiveSync will begin to synchronize your 
information. 
 
[Confirming changes] 
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          ↓ 
        (Synchronization process) 
          ↓ 
[Synchronization complete] 

 

While the ActiveSync connection is active, synchronization will be performed 
whenever information is changed on either the PC or the PDA. 
 
Once a partnership has been established, every time you start your PC (and PDA) 
thereafter, a Bluetooth connection will be opened and ActiveSync will synchronize 
your information. 

Finishing an ActiveSync connection 

Tap and hold on "COM7" in the Bluetooth Settings window, and select 
[ActiveSync Release]. 
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Cancelling a partnership 

Click on [File] "Delete partnership". 
 

Click on the [Yes] button when the confirmation message appears. 
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4.6 Fax transmission 

4.6.1  Using a modem station for fax transmission 

Important 
．Please refer to the modem station instruction manual for information on how to 
connect the station to a telephone line. 
．Please ensure that any drivers used to connect the PC to the modem have 
been installed.  

．A Bluetooth passkey (PIN code) is required for you to connect to the modem 
station. Please make a note of your Bluetooth passkey before you start the 
set-up process. 
．A fax application is required for you to be able to send and receive faxes. The 
description below is based on a example using Microsoft Fax, which is installed 
with Windows XP as standard.  
If you are going to use a commercially available fax application, then please refer 
to the manual that came with the application for information on how to send and 
receive faxes. 

Setting up the modem station 

1. Turn on the wireless modem station. 
 
2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New 

Connection]. 

 

Note 
 ．Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
 and then click on [New Connection] from the active [Bluetooth Settings] window.  
 The [Add New Connection Wizard (Welcome to the Add New Connection 
 Wizard)] window will appear. 

3. Select [Custom Mode], and then click on the [Next] button. 
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   The [Add New Connection Wizard (Searching for Bluetooth devices)] window will  
   appear. 

 

   Once the program has finished searching for the devices, the [Add New   
   Connection Wizard (Select Device)] window will appear. 

4. Select the device name of the wireless modem station from [Device List], and 
then click on the [Next] button. 
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   The [Add New Connection Wizard (Searching for Services)] window will appear. 

 

5. If you are connecting to the wireless modem station for the first time, enter 
the passkey for the device from the [Bluetooth Passkey (PIN Code)] window, 
and then click on the [OK] button. 

 89



 

 

   Once the program has finished searching for the services, the [Add New      
   Connection Wizard (Select Service)] window will appear. 

6. Select "Fax" under [Select Service], and then click on the [Next] button. 

 

   The [Add New Connection Wizard (Select COM Port)] window will appear. 

7. Check [Use default COM port], and then click on the [Next] button. 
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Note 
 ．The modem station will be installed to the grayed-out COM port displayed under 
 [Assignment of COM Port] in this window. You will be specifying this COM port in 
 Step (3) of "●Installing a Modem", so please write it down for future reference.  
 
The [Add New Connection Wizard (Connecting to Remote Device)] window will 
appear. 

 

The [Add New Connection Wizard (Modem Settings)] and [Phone and Modem 
Options] windows will appear. 
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8. Click on the "Add..." button in the [Phone and Modem Options] window. 
The [Add New Hardware Wizard (Install New Modem)] window will appear. 
Install the modem by following the instructions in the windows that follow. 

 

Installing a modem  

The [Add New Hardware Wizard (Install New Modem)] window will appear.  

1. Check [Don't detect my modem; I will select it from a list], and then click on 
the [Next] button. 
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   A list of modem manufacturers and models will appear.  

2. Select the desired wireless modem from under [Manufacturer] and [Models], 
and then click on the [Next] button. 

 

Note 
 ．If you have not yet installed a modem driver, click on the "Use Device" button to 
 install one from this window. 
 ．If no modem drivers appear, please select "(Standard Modem Types)" and 
 "Standard 33600 bps modem." 
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A window will appear where you can specify the port to which you can install the 
modem. 

3. Select "Selected Port", specify the COM port to which the modem will be 
installed, and then click on the [Next] button. 

 

Important 
 ．Please specify the COM port displayed in the window pertaining to Step (7) 
 under "●Setting up the modem station."  
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4. Click on the [Continue] button. 
The wizard will display the following window by design, but you may disregard it 
and click on the "Continue" button.  

 

   A window will appear indicating that the modem installation is complete. 

5. Click on the [Finish] button. 

 

6. Confirm that the configured modem has been added to the list in the [Phone 
and Modem Options] window, and then click on the [OK] button. 
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   The [Next] button will be enabled on the [Add New Connection Wizard (Modem 
   Settings)] window. 

7. Click on the [Next] button on the [Add New Connection Wizard (Modem 
Settings)] window. 

 

   The [Add New Connection Wizard (Connection Name Settings)] window will     
   appear. 
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8. Enter the type and name of the icon displayed after registration, and then 
click on the [Next] button. 
Please click on the [Next] button if you are satisfied with the settings. 

 

   The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
   window will appear.  

9. Click on the [Finish] button. 
The settings will be registered, and the icon will appear in the [Bluetooth Settings] 
window. 

 

Setting fax information 

Configure send/receive settings and register fax information.  

1. Select [Start] [Control Panel], and then double-click on the [Printers and 
Other Hardware] icon. 

Note 
 ．If the control panel is displayed in "Classic view", and you use Windows 2000, 
 please start from Step (2).  

2. Double-click on the [Printers and Faxes] icon. 
The [Printers & Faxes] window will appear. 
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3. Click on "Install a local fax printer" in the [Printers and Faxes] window. 

 

   A window showing installed programs will appear, and a Fax icon will have been 
   created in the [Printers and Faxes] screen. 

 

4. Click on "Send a fax" under "Printer Tasks" on the left side of the window. 
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   If you have not yet configured a fax device, the [Fax Configuration Wizard] window 
   will appear. In the window you can enter settings pertaining to the sender        
   (yourself).  

Note 
 ．If the fax configuration information has already been registered, the [Send Fax 
 Wizard] window, which can be viewed under "Sending a fax" below, will appear 
 instead of the [Fax Configuration Wizard] window.  

5. Enter the sender information, and click on the [Next] button 
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Note 
 ．The sender information that you configure here will be automatically appended 
 as header information when you send a fax.  

6. Select a device to be used for fax transmissions, enable the device for 
sending or receiving, and then click on the [Next] button 

 

Note 
 ．If [Enable Receive] is selected, the device will be on standby for receiving faxes 
 even if it is not sending or receiving anything, and therefore will be in continuous 
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 connection to the wireless modem (when COM Auto Connect is on). 
 Please decide whether to select this option based on the desired objective and/or 
 frequency of transmission.  

7. Click on the [Next] button. 
It is important that you do not change the transmitter subscriber identification.  

 

8. Click on the [Finish] button. 
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Setting fax information 

Important 
．The Fax service must be enabled for sending in order for you to send a fax. 
Please refer to "Using a wireless modem station" under "Troubleshooting" for 
how to change the send and receive settings once the service has been 
configured. 

1. Double-click on the [Fax] icon in the Control Panel.  
The [Fax Console] window will appear. 

 

2. In the [Fax Console] window, click [File]→[Send fax]. 
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will appear.  

3. Click on the [Next] button. 
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   The [Send Fax Wizard (Recipient Information)] window will appear. 

4. Enter the name and fax number of the destination party, and then click on the 
[Next] button. 

 

   The [Send Fax Wizard (Preparing the Cover Page)] window will appear. 

5. Specify the cover page template, subject line, and note (body text), and then 
click on the [Next] button. 
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   The [Send Fax Wizard (Schedule)] window will appear.  

6. If you wish to send the fax immediately, select "Now", and then click on the 
[Next] button. 

 

   The [Send Fax Wizard (Completing the Send Fax Wizard)] window will appear. 

7. Confirm the destination information and transmission details, and then click 
on the [Finish] button. 
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   The software will automatically dial the number and send the fax. 

 

Once the fax has been sent, Fax Monitor will revert to standby mode. 

 

Receiving a fax 

1. When a fax arrives, the Fax Monitor will start automatically as the fax is 
received. 
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   Once the fax has been received, the Fax Monitor will revert to standby mode.  

Note 
 ．If you have enabled manual fax reception, the message below will appear when 
 a fax arrives. 

 

Click on the message with your mouse to receive the fax. 

2. Double-click on the [Fax] icon in the Control Panel. 
The [Fax Console] window will appear. 

3. In the [Fax Console] window, double-click on the fax that has arrived. 
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4.6.2  Using a mobile telephone for fax transmission 

Important 
．Please ensure that any drivers used to connect the PC to the mobile telephone 
have been installed. 
．Bluetooth passkey (PIN code) is required for you to connect to the mobile 
telephone. Please make a note of your Bluetooth passkey before you start the 
set-up process.  
．A fax application is required for you to be able to send and receive faxes. The 
description below is based on a example using Microsoft Fax, which is installed 
with Windows XP as standard. 

Setting up the mobile telephone 

1. Turn on the mobile telephone, and set it to be connectable via Bluetooth. 
 
2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New 

Connection]. 

 

Note 
 ．Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
 and then click on [New Connection] from the active [Bluetooth Settings] window.  
 The [Add New Connection Wizard (Welcome to the Add New Connection 
 Wizard)] window will appear. 

3. Select [Custom Mode], and then click on the [Next] button. 
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   The [Add New Connection Wizard (Searching for Bluetooth devices)] window will  
   appear. 

 

   Once the program has finished searching for the devices, the [Add New   
   Connection Wizard (Select Device)] window will appear. 

4. Select the device name of the mobile telephone from [Device List], and then 
click on the [Next] button. 
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   The [Add New Connection Wizard (Searching for Services)] window will appear. 

 

5. If you are connecting to the mobile telephone for the first time, enter the 
passkey for the device from the [Bluetooth Passkey (PIN Code)] window, and 
then click on the [OK] button. 
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   Once the program has finished searching for the services, the [Add New      
   Connection Wizard (Select Service)] window will appear. 

6. Select "Fax" under [Select Service], and then click on the [Next] button. 

 

   The [Add New Connection Wizard (Select COM Port)] window will appear. 

7. Check [Use default COM port], and then click on the [Next] button. 
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Note 
 ．The mobile telephone will be installed to the grayed-out COM port displayed 
 under [Assignment of COM Port] in this window. You will be specifying this COM 
 port in Step (3) of "●Installing a Modem", so please write it down for future 
 reference.  
 
The [Add New Connection Wizard (Connecting to Remote Device)] window will 
appear. 

 

The [Add New Connection Wizard (Modem Settings)] and [Phone and Modem 
Options] windows will appear. 
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8. Click on the "Add..." button in the [Phone and Modem Options] window. 
The [Add New Hardware Wizard (Install New Modem)] window will appear. 
Install the modem by following the instructions in the windows that follow. 

 

Installing a modem  

The [Add New Hardware Wizard (Install New Modem)] window will appear.  

1. Check [Don't detect my modem; I will select it from a list], and then click on 
the [Next] button. 
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   A list of modem manufacturers and models will appear.  

2. Select the desired mobile telephone from under [Manufacturer] and [Models], 
and then click on the [Next] button. 

 

Note 
 ．If you have not yet installed a mobile telephone driver, click on the "Use Device" 
 button to install one from this window. 
 ．If no mobile telephone drivers appear, please select "(Standard Modem Types)" 
 and "Standard 33600 bps modem." 
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A window will appear where you can specify the port to which you can install the 
modem. 

3. Select "Selected Port", specify the COM port to which the modem will be 
installed, and then click on the [Next] button. 

 

Important 
 ．Please specify the COM port displayed in the window pertaining to Step (7) 
 under "●Setting up the modem station."  
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4. Click on the [Continue] button. 
The wizard will display the following window by design, but you may disregard it 
and click on the "Continue" button.  

 

   A window will appear indicating that the modem installation is complete. 

5. Click on the [Finish] button. 

 

6. Confirm that the configured modem has been added to the list in the [Phone 
and Modem Options] window, and then click on the [OK] button. 
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   The [Next] button will be enabled on the [Add New Connection Wizard (Modem 
   Settings)] window. 

7. Click on the [Next] button on the [Add New Connection Wizard (Modem 
Settings)] window. 

 

   The [Add New Connection Wizard (Connection Name Settings)] window will     
   appear. 
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8. Enter the type and name of the icon displayed after registration, and then 
click on the [Next] button. 
Please click on the [Next] button if you are satisfied with the settings. 

 

   The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
   window will appear.  

9. Click on the [Finish] button. 
The settings will be registered, and the icon will appear in the [Bluetooth Settings] 
window. 

 

Setting fax information 

Configure send/receive settings and register fax information.  

1. Select [Start] [Control Panel], and then double-click on the [Printers and 
Other Hardware] icon . 

Note 
 ．If the control panel is displayed in "Classic view", and you use Windows 2000, 
 please start from Step (2).  

2. Double-click on the [Printers and Faxes] icon. 
The [Printers & Faxes] window will appear. 
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3. Click on "Install a local fax printer" in the [Printers and Faxes] window. 

 

   A window showing installed programs will appear, and a Fax icon will have been 
   created in the [Printers and Faxes] screen. 

 

4. Click on "Send a fax" under "Printer Tasks" on the left side of the window. 
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   If you have not yet configured a fax device, the [Fax Configuration Wizard] window 
   will appear. In the window you can enter settings pertaining to the sender        
   (yourself).  

Note 
 ．If the fax configuration information has already been registered, the [Send Fax 
 Wizard] window, which can be viewed under "Sending a fax" below, will appear 
 instead of the [Fax Configuration Wizard] window.  

5. Enter the sender information, and click on the [Next] button 
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Note 
 ．The sender information that you configure here will be automatically appended 
 as header information when you send a fax.  

6. Select a device to be used for fax transmissions, enable the device for 
sending or receiving, and then click on the [Next] button 

 

Note 
 ．If [Enable Receive] is selected, the device will be on standby for receiving faxes 
 even if it is not sending or receiving anything, and therefore will be in continuous 
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 connection to the wireless modem (when COM Auto Connect is on). 
 Please decide whether to select this option based on the desired objective and/or 
 frequency of transmission.  

7. Click on the [Next] button. 
It is important that you do not change the transmitter subscriber identification.  

 

8. Click on the [Finish] button. 

 

Please refer to the same procedure of “Sending a fax” and “receiving a fax” in the “using a 
modem station for transmission” section. 
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4.7 Using a Bluetooth-compatible camera 

Connecting the camera 

1. Click on [Start ] [All Programs] [Bluetooth] [Remote Camera].  

Note 
 ．In Windows 2000, click on [Start]→[Programs]→[Bluetooth]→[Remote 
 Camera].  

 

   The [Remote Camera] window will appear. 

2. Turn on the camera, and set it to be connectable via Bluetooth.  

Note 
 ．Different cameras are operated in different ways, depending on the 
manufacturer  and model used. Please refer to the instruction manual for further 
details on how  to operate your camera.  

3. Click on the [Camera Search...] button. 

 

   The camera will be detected and its icon displayed. 
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4. Right-click on the camera icon, and select [Connect]. 

 

   The camera will be connected, and images from the camera will appear on-screen. 

 

Taking a signal picture 

By placing the mouse cursor over the on-screen image, the camera's operating window 
will appear.  
You can operate the camera from this window. 
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1. Click on the button in the operating window. 
A single image will be captured and sent to the PC. 

 

Taking several consecutive frames 

1. Click on the button in the operating window. 
A succession of images will be captured and sent to the PC. 

 124



 

 

Note 
 ．The remote camera shutter cannot be operated while the camera is connected 
 to the PC.  
 ．The number of consecutive pictures taken can be set to anywhere between 2 
 and 16. 

1. In the [Remote Camera] window, click on [Bluetooth]→[Properties]  
   [Consecutive Image Settings].  
2. Click on the [<][>] buttons to select the number of consecutive images 

to be captured. 

 

Note 
 ．Images are not only sent to the PC, but are stored in the camera's on-board 
 memory as well. 
 Please be aware of the remaining memory capacity when you are taking a large 
 number of pictures. 
 ．Large file sizes are common for high-resolution images, and may take some 
 time to be transferred to the PC. 

Viewing images saves on your PC 

A "Remote Camera" folder will be created in the "Bluetooth" folder under "My Documents" 
during initial set-up. A folder bearing the same name as the camera will be created in it, 
and images will be saved in this folder. 
Click the [Explorer] button in the [Remote Camera] window to display the folder where the 
images have been saved. 
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Note 
 ．This window is an example showing pictures when [Filmstrip] has been selected 
 from the [View] menu in Explorer.  
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4.8 Using a headset to communicate 

Registering the headset 

1. Right-click on the Bluetooth icon in the tasktray, then click on [Add New 
Connection Wizard]. 

 

Note 
 ．Alternatively, you can click on [Start]>[All Programs]>[Bluetooth]>[Bluetooth 
 Settings], then click on [New Connection] in the [Bluetooth Settings] screen that 
 has opened.  

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
screen will appear. 

2. Turn the headset power on. 
Once you have turned on the headset, set the mode to enable a Bluetooth 
connection.  

Important 
 ．The procedure for operating the headset may differ depending on the 
 manufacturer and model. 
 Please consult your user guide for a detailed description of how to operate the 
 unit.  

3. Confirm that [Express Mode] has been selected, then click on the [Next] 
button. 
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   The [Add New Connection Wizard (Searching for Bluetooth Devices)] screen will 
   appear. 

 

   Once the device search has been completed, the [Add New Connection Wizard 
   (Select a Device)] screen will appear. 

4. Select the name of the headset device from the list, then click on the [Next] 
button. 
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5. Answering with the headset. 
If the service has been properly detected, a screen will appear indicating that the 
headset is being called, and a tone will accordingly sound in the headset. 

 

   Please press the headset switch.  

Important 
 ．The procedure for operating the headset may differ depending on the 
 manufacturer and model. 
 Please consult your user guide for a detailed description of how to operate the 
 unit.  

The [Add New Connection Wizard (Configuring (Connecting to Voice Circuit))] 
screen will appear, and device configuration will be performed. 

Note 
 ．If you are connecting to the headset for the first time, or if another Bluetooth 
 audio device (for example, the TOSHIBA Speech Recognizer) has not yet been 
 registered, the following [Found New Hardware Wizard] screen will appear, from 
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 which you can proceed to install the driver. 
 
 If another audio device has already been registered (i.e., the driver has been 
 installed), you can proceed to Step 9 without having to install the driver.  

6. Click on the [Next] button. 

 

   The [Install Hardware] screen will appear. 

7. Click on the [Continue Anyway] button. 
The following screen will appear automatically. You may disregard it and click on 
the [Continue Anyway] button. 

 

   The [Add New Connection Wizard (Completing the Found New Hardware Wizard)] 
   screen, which is the final screen of the installation wizard, will appear. 
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8. Click on the [Finish] button. 

 

Once driver installation is complete, the [Add New Connection Wizard (Enter 
Connection Name)] will appear. 

9. Confirm the information you have entered, and click on the [Next] button. 

 

   The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
   screen will appear. 

 131



 

10. Click on the [Finish] button. 
 
The configuration information will be registered, and an icon will be displayed in the 
[Bluetooth Settings] screen. 

 

Making a connecting to the headset 

You can make a connection to the headset from an icon that has been registered in 
[Bluetooth Settings]. 

Important 
 ．Before making a connection to the headset, please check that you have turned 
 on the headset's power, and it has been enabled for a Bluetooth connection. 
 Please ensure that the following audio-related applications have been closed 
 before you connect the headset to your PC.  

o Windows Media Player, BeatJam, InterVideo WinDVD and other 
music/audio playback software  

o Windows Messenger and other e-conferencing software  
o LaLaVoice and other voice-recognition software  

 If you wish to use these applications, please terminate the headset connection 
 before you launch them.  

1. Right-click on the headset icon, then click on [Connect]. 
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2. Answer with the headset. 
  
A screen will appear indicating that the headset is being called, and a tone will 
accordingly sound in the headset. 
Please press the headset switch. 

 

If the connection has been properly established, the icon's appearance will change    
to indicate a connected state. 

 

You may now launch conferencing and voice-recognition software and use the headset. 

Disconnecting from the headset 

Please follow the steps below to disconnect from the headset. 

1. Right-click on the headset icon in the [Bluetooth Settings] screen, then click 
on [Disconnect]. 
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A message will appear, requesting confirmation that you wish to disconnect. Click on 
the [Yes] button. 
The icon on the [Bluetooth Settings] screen will appear as shown below, indicating that 
the device has been disconnected.
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4 
 

5 
Chapter 5 
Advanced features 

5.1 Making a device undiscoverable to other users 

1. Right-click on the Bluetooth icon in the task tray, and then click on 
[Device Properties]. 

 

   The [Device Properties] window will appear. 

2. Select [Non-discoverable mode] in [Discoverability mode] under the 
[Mode] tab, and then click on the [OK] button. 

 



 

   Your device will now be undetectable by other users, even when they search 
for    other devices. 

Note 
 ．Other devices are still able to establish connections with your device even 
if you  have enabled the Non-discoverable mode. 
 Please enable "Non-connectable mode" if you wish to reject connections 
from  other devices. 

5.2 Encrypting the content of your transmissions 

Since Bluetooth communication is conducted wirelessly, there is always the 
possibility that a third party may be able to intercept your transmissions. 
You can use encryption to render the content indecipherable to anyone who 
manages to intercept it. 

Important 
 ．Encrypting your transmissions will still not guarantee complete security. 
 Accordingly, please be aware that transmitting data is conducted with an 
 element of risk for the user.  

1. Right-click on the Bluetooth icon in the task tray, and then click on 
[Device Properties]. 

 

The [Device Properties] window will appear. 

2. Select [Link Level Enforced Security] in [Security Mode] under the 
[Mode] tab, put a check next to [Encryption], and then click on the [OK] 
button. 
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Note 
 ．Once you have configured the security mode, a window will appear when 
you  first make a connection to another device, prompting you to enter a 
Bluetooth  passkey (PIN code). 
 Please click on the [OK] button after you have entered the passkey. 

 

  ．The window in which you enter the passkey will not appear once you have 
   connected more than two times to the device. 

5.3 Changing the default connection 

The "default connection" refers to the dial-up connection configured for use 
whenever a connection is made to the Internet. 
If several connections have been registered, you can change the default connection 
by following the procedure below. 

1. Start Internet Explorer. 
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2. Click on [Tools]→[Internet Options...]. 

 

   The [Internet Options] window will appear. 

3. Click on the [Connections] tab. 

 

   In this window, "Direct Connection" is set as the default, and "Never dial a 
      connection" has been selected. 
   Change the settings so that "London A" will always be dialled when you 
connect to    the Internet. 

4. Select "Always dial my default connection". 
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5. Click on "London A", and then click on the [Set Default] button. 

 

   "London A" has been changed to the default connection. 
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5.4 Manually creating a virtual Bluetooth COM port 

In order for a PC to connect to and communicate with a Bluetooth device, the 
Bluetooth Utility will create a gateway for data to be exchanged between the 
respective devices. This gateway is known as a "port" (or "virtual COM port"). 
 
Since one virtual COM port will be allocated to each device, trouble-free 
communication will still be possible even if several devices are being used. 
 
When you use the Bluetooth Utility, a virtual COM port will be automatically created 
on set-up; however, virtual COM ports can be created manually if so needed. 

5.4.1  Clients and servers 

When Bluetooth communications are performed, there will always be a 
"client/server" relationship between the various devices. A "client" is a device that 
sends certain requests to another device, while a "server" is a device that provides a 
service on receipt of such requests from another device.  
 
For example, when a PC issues a print command to a wireless printer, the PC 
functions as the client, while the printer functions as the server. 
When a PDA or other device attempts to receive files located on a PC by means of 
file transfer protocol, the PC functions as the server, while the PDA functions as the 
client. 
 
Virtual Bluetooth COM ports can be created both for clients and servers.  
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• Bluetooth virtual COM port for a client 
Virtual COM port used when your device is the client, and requests are sent 
to another device. 

• Bluetooth virtual COM port for a server 
Virtual COM port used when your device is the server, and requests are 
received from another device. 

5.4.2  Creating a virtual COM port 

1. Click on the [Printers and Other Hardware] icon in the Control Panel. 

 

   The [Printers and Other Hardware] window appears. 

2. Double-click on the [Bluetooth Local COM] icon. 
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   The main Bluetooth Local COM window will appear.  

Note 
 ．Even when the Control Panel appears in Classic view, please simply click 
on  the [Bluetooth Local COM] icon. 

 

o No such distinction between viewing formats exists in Windows 2000. 
 

3. Click on the [Add...] button. 
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   The [Bluetooth Local COM Wizard] window, from where you can create a 
virtual    COM port, will appear. 

 

   Start from this window when creating Bluetooth virtual COM ports for either 
servers    or clients. 

5.4.3 Deleting a virtual COM port 

Note 
 ．You can only delete virtual COM ports created by the Bluetooth Local 
COM  utility. 

1. Select the port you wish to delete from the [Bluetooth Local COM] 
window, and then click on the [Delete] button. 
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   A message will appear asking you to confirm that you wish to delete the port. 

2. Click on the [Yes] button. 

 

   The port will be deleted. 

3. Click on the [OK] button. 
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6 
Chapter 6 
Troubleshooting 

6.1 General operation of the Bluetooth Utility 

Bluetooth Manager 

   Q: Bluetooth icon does not appear in task tray. 

• If the Bluetooth icon does not appear in the task tray, Bluetooth Manager will 
not be active, which will prevent you from being able to use any of the 
functions of the Bluetooth Utility. 
Start the utilities as instructed below to enable Bluetooth Manager to start 
automatically and allow all functions to be utilized. 
 
Bluetooth Settings 
(from Windows XP) 
[Start] > [All Programs] > [Bluetooth] > [Bluetooth Settings] 
(from Windows 2000) 
[Start] > [Programs] > [Bluetooth] > [Bluetooth Settings] 
 
Remote Camera 
(from Windows XP) 
[Start] > [All Programs] > [Bluetooth] > [Remote Camera] 
(from Windows 2000) 
[Start] > [Programs] > [Bluetooth] > [Remote Camera] 
 
Wireless File Transfer 
(from Windows XP) 
[Start] > [All Programs] > [Bluetooth] > [Wireless File Transfer] 
(from Windows 2000) 
[Start] > [Programs] > [Bluetooth] > [Wireless File Transfer] 

   Q: Unable to turn on Bluetooth. 

• If the wireless communication switch on your PC has been turned off, the 
message below will appear, and you will not be able to turn the power on from 
Bluetooth Manager. 



 

 

   Please confirm whether the wireless communication switch has been turned 
   on. 

Bluetooth Settings 

   Q: Clicking on the [New Connection] button brings up the message "Unable to 
prepare        
   Bluetooth." 

• The wireless communication switch is turned off.  
Please switch it on. 

   Q: Remote device(s) cannot be detected 

• The other device(s) may have been set to Non-discoverable mode. 
Please check the mode settings on the device. 

   Q: Services on a remote device are undiscoverable 

• The other device may be using a profile that is not supported by the Bluetooth 
Utility 
Please check the profile being used on the other device. 

• The following profiles are compatible with Bluetooth Settings. 

DUN, FAX, LAP, SPP, HID, HCRP, FTP, OPP, HSP, PAN and BIP 

Devices running profiles other than those above will not be able to be 
registered with Bluetooth Settings 

Bluetooth Information Exchanger 

   Q: Bluetooth Information Exchanger icon does not appear on Desktop 
• Bluetooth Information Exchanger is not active. Please follow the procedure 

below to start the utility.  
 

1. Right-click on the Bluetooth icon in the task tray 
2. Click on [Options] > [Enable Bluetooth Information Exchanger], 

and then check [Enable Bluetooth Information Exchanger] 
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 The Bluetooth Information Exchanger icon will appear on the Desktop. 

 

   Q: Transfer failed when sending a file using the right-click menu. 

• FTP or OPP are the sending profiles available when you select a file, 
right-click it, and then click on [to Bluetooth] to send it. 
If the destination device does not support either of these profiles, you will not 
be able to send files using the right-click menu. 
 
File transfer will also be unsuccessful if you use FTP to send a file to a device 
that only supports OPP. 
In such cases, please click on [Bluetooth] > [Profiles] from [Bluetooth 
Information Exchanger], and enter the settings shown under Transfer mode.  

   Q: Cannot open shared folder on other device with "File Transfer". 

• The other device may have a certain security level enforced 
(Non-connectable mode etc). Please confirm the security settings of the other 
device. 
Please enter the correct password if you are asked to enter one.  

Remote Camera 

• See "Using a camera" 

Bluetooth Local COM 

   Q: Cannot add port 

• A maximum of 64 virtual COM ports can be added. You will be unable to add 
another port if 64 ports have already been configured. 
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6.2 Using a wireless modem station 

Q: Modem station cannot be detected. 

• If the modem station is connected to and is being used by another device, the 
modem station will be undetectable even if you search for it.  

Q: Cannot connect to modem station 

• If the modem station is connected to and is being used by another device, no 
other device will be able to connect to the modem station. 

Q: Bluetooth passkey entry failed 

• The Bluetooth passkey (PIN code) comprises a sequence of alphanumeric 
characters, with the letters able to be rendered in upper and lower case. 
If [Caps Lock] is on, the Bluetooth passkey may not be able to be entered 
correctly.  

Q: Cannot connect to telephone line 

• Please ensure that the telephone cable is connected from the socket to the 
"LINE" terminal on the modem station.  

Note 
 ．If the telephone cable has come loose because it has not been fully 
inserted  into the socket, the resulting poor contact may prevent data from 
being  transmitted accurately. 
 ．Communication will be impossible if the interior of the cable has been 
broken.  Please replace the cable with another one.  

• Please ensure that the two slide switches on the underside of the main unit 
have been set to the "NORMAL" and "MODEM" positions respectively.  

Q: Cannot connect to the Internet 

• The telephone number of the connection (i.e., the telephone number for the 
access point of your Internet service provider) may not be correct. Please 
check the telephone number. 

• The user ID and/or password for the provider with whom you have signed up 
may have been entered incorrectly. Please check the user ID and password. 

• The default connection may have been configured with different settings. 
Please set the connection configured for mobile telephone use as the default 
connection. 

• When you place a call using a company switchboard or other exchange, the 
system may require you to enter a "0" before the telephone number itself. 
Please check the type of telephone line you are using. 
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Q: Cannot send or receive faxes 

• Once you have registered a wireless modem station as your fax server, you 
will need to enter the fax settings from the [Printer and Faxes] window in the 
Control Panel. 
Please refer to "Using a modem station for fax transmissions" for information 
on the configuration procedure. 

• The telephone number of the fax destination may have been entered 
incorrectly. Please check the telephone number. 

• If the setting under COM Auto Connect Settings has been set to "Off", a 
connection will not automatically be established with the modem. Please 
connect to the modem manually. 

• When you place a call using a company switchboard or other exchange, the 
system may require you to enter a "0" before the telephone number itself. 
Please check the type of telephone line you are using. 

• The fax service may not have been enabled for sending (or receiving). 
Please check the settings by following the procedure below. 

1. Open [Printers and Faxes] from the Control Panel, right-click on 
the [Fax] icon, and then click on [Properties]. 

 

 The [Fax properties] window will appear. 

2. Select the [Device] tab, right-click on the modem you wish to use, 
and then click on [Properties]. 

 149



 

 

3. Select the [Send] tab, and then confirm that "Enable device to 
send" has been checked. 

 

4. Select the [Receive] tab, and then confirm that "Enable device to 
receive" has been checked (when you wish to receive faxes). 
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5. Click on the [OK] button. 

6.3 Using an access point 

Q: Access point cannot be detected. 

• If the access point is connected to and is being used by another device, the 
access point will be undetectable even if you search for it. 

Q: Cannot connect to access point. 

• If the access point is connected to and is being used by another device, no 
other device will be able to connect to the access point. 

Q: Cannot connect to LAN. 

• The LAN cable may not be properly connected to the access point. Please 
check the connection status.  

Note 
 ．If the LAN cable has come loose because it has not been fully inserted 
into the  socket, the resulting poor contact may prevent data from being 
transmitted  accurately. 
 ．Communication will be impossible if the interior of the LAN cable has been 
 broken. Please replace the cable with another one. 

• The access point may not have been configured correctly, and may not be 
able to maintain the connection to the LAN. 
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Please refer to the product instruction manual for information on how to 
configure your access point.  

Q: Cannot connect to the Internet. 

• If you are using a LAN to connect to the Internet, the LAN environment of the 
company or location where you are trying to establish the connection may 
require you to connect via a proxy server. 

6.4 Using a mobile telephone 

Q: Mobile telephone cannot be detected. 

• If the mobile telephone is connected to and is being used by another device, 
the mobile telephone will be undetectable even if you search for it.  

Q: Cannot connect to mobile telephone. 

• If the mobile telephone is connected to and is being used by another device, 
no other device will be able to connect to the mobile telephone. 

Q: Cannot send images to mobile telephone. 

• Please use the appropriate transfer method, according to the profiles 
supported by your mobile telephone. 
 
If OPP is supported: right-click on a file to send it 
 
If BIP is supported: use "Image transfer" under Bluetooth Information 
Exchanger to send images 

Q: Cannot connect to the Internet. 

• The telephone number of the connection (i.e., the telephone number for the 
access point of your Internet service provider) may not be correct. Please 
check the telephone number. 

• The user ID and/or password for the provider with whom you have signed up 
may have been entered incorrectly. Please check the user ID and password. 

• The default connection may have been configured with different settings. 
Please set the connection configured for mobile telephone use as the default 
connection. 

Q: Cannot send or receive faxes. 

• Once you have registered a mobile telephone as your fax server, you will 
need to enter the fax settings from the [Printer and Faxes] window in the 
Control Panel. 
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Please refer to "Using a modem station for fax transmissions" for information 
on the configuration procedure. 

• The telephone number of the fax destination may have been entered 
incorrectly. Please check the telephone number. 

• If the setting under COM Auto Connect Settings has been set to "Off", a 
connection will not automatically be established with the modem. Please 
connect to the mobile telephone manually. 

• The fax service may not have been enabled for sending (or receiving). 
Please check the settings by following the procedure below. 

1. Open [Printers and Faxes] from the Control Panel, right-click on 
the [Fax] icon, and then click on [Properties]. 

 

 The [Fax properties] window will appear. 

2. Select the [Device] tab, right-click on the modem you wish to use, 
and then click on [Properties] . 
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3. Select the [Send] tab, and then confirm that "Enable device to 
send" has been checked. 

 

4. Select the [Receive] tab, and then confirm that "Enable device to 
receive" has been checked when you wish to receive faxes). 
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5. Click on the [OK] button. 

6.5 Using a PDA 

Q: Cannot make an ActiveSync connection. 

• Please confirm that you have installed ActiveSync v3.7 or higher on your PC. 

• ActiveSync is installed to COM7 as a default. Please refer to "Synchronizing 
data with a PDA" and re-configure your ActiveSync connection. 
If a port other than COM7 has been used, please amend the ActiveSync 
connection settings accordingly. 

Q: Cannot locate a saved file. 

• The type of file sent to your PDA, as well as the profile used to send the file, 
may affect where folders saved on your PDA are located. 
 
Examples: 
Images transferred to your PDA using "Image transfer" > saved in the "Image 
transfer" folder 
Images transferred to your PDA using "File transfer" > saved in the "Shared 
folder"  

6.6 Using a camera 

Q: Camera cannot be detected. 
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• If the camera is connected to and is being used by another device, the 
camera will be undetectable even if you search for it.  

Q: Cannot connect to camera. 

• If the camera is connected to and is being used by another device, no other 
device will be able to connect to the camera. 

Q: Images from the camera can be displayed, but no pictures can be taken. 

• The memory card in the camera may be full. 
Please make a backup of all your necessary data on alternative media, then 
delete the images from the memory card, and ascertain how much free space 
remains.  

Q: Camera images do not appear in window. 

• The camera may not have been set to remote camera mode (image browse 
mode, configuration mode, etc). 
 
Certain cameras will end the Bluetooth connection automatically if you 
change the settings in a mode other than remote camera mode. Please 
re-connect to the camera when you next wish to use the device in remote 
camera mode.  

6.7 Using a Bluetooth Headset 

Q: Bluetooth Headset cannot be detected. 

• If the Bluetooth Headset is connected to and is being used by another device, 
the Bluetooth Headset will be undetectable even if you search for it. 

Q: Cannot connect to Bluetooth Headset. 

• If the Bluetooth Headset is connected to and is being used by another device, 
no other device will be able to connect to the Bluetooth Headset.  

• A Bluetooth connection will be impossible if the Bluetooth Headset is 
connected to a power adaptor. 
Please remove the power adaptor and re-connect. 

Q: Sound cuts out/cannot hear anything. 

• Using a Bluetooth headset with other Bluetooth devices may cause problems 
such as interruptions in sound, reduced transfer speed or failure during file 
transfer, and disconnection of the other Bluetooth devices. We strongly 
recommend using a Bluetooth headset on its own and not in connection with 
other Bluetooth devices. 
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• Please confirm that the Bluetooth Headset is being operated correctly (for 
example, ensure that the correct mode (audio or communications) mode has 
been selected). 

• Please confirm that the voice file or CD is being played back normally on your 
PC. 

• Please check the volume settings on your Bluetooth Headset and PC. 

• If Windows Media Player or another audio-related application is active when 
you try to connect your Bluetooth Headset, you may find it impossible to 
connect properly to the Bluetooth Headset, or even to use it at all. 
Please start such applications after you have connected to the Bluetooth 
Headset. 
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Federal Communication Commission Interference Statement 
 

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules.  These limits are designed to provide 
reasonable protection against harmful interference in a residential installation.  This 
equipment generates, uses and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio 
communications.  However, there is no guarantee that interference will not occur in a 
particular installation.  If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one of the following measures: 
 
- Reorient or relocate the receiving antenna. 
- Increase the separation between the equipment and receiver. 
- Connect the equipment into an outlet on a circuit different from that 

to which the receiver is connected. 
- Consult the dealer or an experienced radio/TV technician for help. 
 
FCC Caution: Any changes or modifications not expressly approved by the party 
responsible for compliance could void the user's authority to operate this equipment. 
 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired 
operation. 
 
The antenna(s) used for this transmitter must not be co-located or operating in conjunction 
with any other antenna or transmitter. 

 
This device is intended only for OEM integrators under the following conditions: 
1) The transmitter module may not be co-located with any other transmitter or antenna. 
As long as the condition above is met, further transmitter test will not be required. 
However, the OEM integrator is still responsible for testing their end-product for any 
additional compliance requirements required with this module installed (for example, digital 
device emissions, PC peripheral requirements, etc.).    The final end product must be labeled

           in a visible area with the following: "Contains TX FCC ID: NLFGUBTCR42M". 
 

         IMPORTANT NOTE: In the event that these conditions can not be met (for example certain 
         laptop configurations or co-location with another transmitter), then the FCC authorization is 
        no longer considered valid and the FCC ID can not be used on the final product. In these 
      circumstances, the OEM integrator will be responsible for re-evaluating the end product 
          (including the transmitter) and obtaining a separate FCC authorization. 

 


